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Operator Safety Summary

The general safety information in this summary is for operators of the Exicor® Micro
Imager. Specific warnings and cautions may be found throughout the manual where
they apply but may not appear in this summary.

Terms

DANGER statements identify conditions or practices that will result in personal injury
or loss of life.

WARNING statements identify conditions or practices that could result in personal
injury or loss of life.

CAUTION statements identify conditions or practices that could result in damage to
the equipment or other property.

NOTICE statements identify conditions or practices that are important in proper use
of the equipment to get the expected results.

Labels
The system identification label below is placed on the rear of the Microlmager frame.

rass w evergren ply S8 | {INDS”

(503) 690-2000 ‘-‘ 89’ INSTRUMENTS

Model: Exicor Mircrolmager SN:0010

Mfd: June 2014

& Class 2 per EN60825-1 (2007)

Electrical Ratings

Output: 24VDC at 4.2 Amps Max

Figure 1 System identification label

The wording on this label is:
Model No. , Serial No. , Manufactured:

Power Source

This product is intended to operate from a power source that will not apply more
than 250 volts rms between the supply conductors or between either the supply

Exicor Microlmager User Manual 9



Do Not Operate without Covers

conductor and ground. A protective ground connection by way of the grounding
connector in the power cord is essential for safe operation. The user should supply
power to the system that will provide at least the following amount of current at the
corresponding supply voltage:

100-240VAC, 50/60Hz, 1.5A MAX

The Microlmager system uses a single AC power cord to power a DC power brick. If
the power cord needs to be replaced for any reason, make sure that the
replacement cord is rated for the voltage and current noted above

Do Not Operate without Covers

To avoid personal injury, only operate this product with all covers and panels
installed.

Light Safety

The light source is located in the bottom module of the system. It is a 3 wavelength
LED that outputs <1mW. Removing any covers (all of them require tools) can
expose a user to the LED light. The light beam path is shown in Figure 2.

CAUTION

Avoid direct eye exposure to the beam and to reflections from
shiny objects.

This or any other low power LED can cause a temporary
inability to see clearly, much as is experienced by exposure to
the flash of a camera.

Use of controls or adjustments or performance of procedures
other than those specified herein, may result in hazardous LED
light exposure.

Persons other than qualified maintenance personnel should not
unnecessarily remove covers.

10 Exicor Microlmager User Manual



Chapter 1: System Overview

Light Beam

Figure 2 Light beam path

Mechanical Safety

Be careful to have hands clear of any pinch points while operating the focus block
and sample stage.

Electrical Safety

Rear panel outlets, other than the DC input are only USB 3.0 connectors which do
not exceed 5 Volts.

The Exicor® Microlmager contains no user-serviceable components. Refer any
maintenance or adjustment needs to Hinds Instruments, Inc.

Do not allow any liquids to get inside the equipment.

Maintenance of the other elements of the system should be referred to Hinds
Instruments, Inc. or other trained personnel.

Exicor Microlmager User Manual 11
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System Overview

The Exicor® Microlmager is a highly sensitive polarization imaging system that
utilizes different microscope objectives to image very small features of samples. It
measures Retardation and fast axis angle. Samples need to be flat and transparent
to the wavelength that is being used.

System Description

Listed below are the main components of the system. See Figure 3 for the
component layout.

Top Module: The Top Module houses the top half of the optical components of the
imaging system.

Focus Block: The Focus Block has both fine and coarse adjustment knobs. Use the
larger outer knob to adjust the coarse focus and the smaller inner knob to adjust the
fine focus.

Bottom Module: The Bottom Module houses the electronics of the system as well
as the bottom half of the optical train of the system. The bottom half also houses the
light source.

Sample Stage: The Sample Stage can be moved in the vertical direction by the
focus block while having an X travel of 76mm and a Y travel of 50mm.

Microscope Objective: The Microlmager comes with a variety of different options in
objectives. Most commonly in 2X, 5X, and 10X. To use a different objective, simply
unscrew the current objective and replace it with the desired objective. The focus
block may need to be readjusted to bring the sample back into focus.

Exicor Microlmager User Manual 13



System Description

//—Tcp Module

] |
Microscope Objective T
N_ T _~——Focus Block

Sample Stage ! ,

i L f Ve

,,,,,,,,,,

L /—Bottom Module

Figure 3 System main components

-4— POLARIZER

CUSTOMER SAMPLE

P« POLARIZER (09

Figure 4 Main optical components of the system
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Chapter 1: System Overview

General Dimensions

Units: mm

Fig
' L*w

Figure 5 Dimensions

Exicor Microlmager User Manual

15



General Dimensions
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2

System Operating
Requirements/Setup

Component Placement

The computer and monitor need to be placed within 0.5 meter of the system to
facilitate connection of all hardware control cables.

The system uses a fan to keep internal electrical components located in the base of
the system cool. The system must be placed such that airflow from the rear panel is
not restricted.

Power Connections

The Exicor® Microlmager system is designed to use an external DC power supply
that outputs 24VDC while accepting 100-240VAC, 50/60 Hz. User adjustment
should not be necessary for any internal components due to changes in power.

The Exicor® Microlmager system requires a single power outlet. The computer and
monitor need to be powered separately from a user-supplied wall outlet or outlet
strip.

Calibration

The Exicor® Microlmager has been calibrated by Hinds Instruments, Inc. prior to
shipment. The instrument should require no further adjustment for most applications.
Regularly zeroing the system will ensure the best low level sensitivity for all
measurement parameters.

Note: All systems sold by Hinds Instruments are currently installed and
supported only through Hinds Instruments, Inc. and authorized
distributors.

Exicor Microlmager User Manual 17
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Operating The System

System Initialization
To initialize the Exicor® Microlmager system, starting with the power off:

1. Turn the power switch to the ON position. The power switch is found on the
rear panel of the machine.

2. Launch the software by double clicking on the Exicor® desktop icon.

During hardware initialization, the user might notice the LED and camera will
initialize using the settings from the previous use.

If there are no errors during the initialization phase, the main window will come up as
shown in Figure 6.

Exicor Microlmager User Manual 19



Loading a Sample

|—Rehldun(e and angle ﬁ

Mode: Camera: UI337xCP-M Controller: LED FPGA Driver V0. Count: 0

Figure 6 Main Window
If an error is witnessed during the initialization phase, see section 7 “Troubleshooting
& Help” on page 50 for system initialization errors.

To start the system if the hardware has already been powered up, such as from a
computer restart, simply start the software.

Loading a Sample

This system includes a basic manually operated sample stage. The best way to get
reproducible measurements is to make a custom sample holder that holds the
sample and fastens to the stage in a repeatable way. Hinds Instruments can also
supply custom sample holders as an option.

Use the following steps to load a sample:

1. Place the sample on the stage. Do not hold the sample to the stage in a way
that might put stress on the sample.

2. Using the manual adjusters, move the sample to the desired location on the
screen. The adjustment knob controls both the X and Y-axis adjustments. The
X-axis is controlled by the bottom part of the knob. The Y-axis is controlled by
the top part of the knob. See Figure 7.

20 Exicor Microlmager User Manual



Chapter 3: Operating the System

X-Axis Control

Y-Axis Control
— /

Figure 7 Stage axis controls

Note: It is preferable to wait at least 10 minutes before measuring samples
after handling in order for the sample to reach thermal equilibrium. Handling
the sample can change its temperature temporarily, which may also affect the
retardation measurement. The wait time may be different for samples of
different sizes or different material.

Measuring a Sample
1. Choose the color of light desired by clicking the corresponding checkbox.

2. Choose the Objective setting corresponding to the objective in the instrument
in the objective menu.

¢ Note: The use of an objective on the system that doesn’t match the
setting will result in inaccurate measurements.

3. Set the Light Level/Exposure by clicking the Auto Set Exposure Button
4. Click sample on the left side of the screen.

Once the scan starts, there is a status bar at the bottom showing the amount of
progress of the scan.

When the scan is complete, the software will switch to the Data tab and display the
results as shown in Figure 8.
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System Shutdown

Eﬁcorh;\agenmis_ 22 14.32 30 Green
FILE TOOLS HELP

Display Live| Data Colorbar | Analysis | Datasets
(Intensity —  + | ' + ]| Colorbar

" Color Map
** 036

-‘\\:\\3 032
— 029
025

- 022

018
0.14

011

I

Intensity

(Retardance

Intensity
Max 036 | AU
(Angle of the fast axis Min 000 AU

(Retardance and intensity

L L
0 100 200
Retardance

Camera: UI337xCP-N Controller: LED FPG/ Count: 0

Figure 8 Completed scan

If the data needs to be saved, simply select File->Save and select which information
to save.

System Shutdown
1. Close the Exicor® software.

Move the start/stop switch to the OFF position. All hardware devices inside the
system will shut down. The PC and monitor can be shut down independently if
necessary.
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4

Software Interface

Depending on the options purchased with the Microlmager, different software
options may be available. This chapter explains the rest of the software interface in
detail, including:

Calibration

Opening Files
Setting Exposure
Changing Objectives
Fast Mode

Offsets

Display of Data
Evaluation of Data
Analysis

Multi-Order Samples
Auto-Collect

Calibration

The system does not need to be recalibrated on a regular basis but it is up to the
user to decide if they want to recalibrate the system. Reasons Hinds Instruments
would recommend recalibration include the following:

1. Moving the system from to a different room.

2. Adding additional objectives obtained from Hinds Instruments.

3. There has been a substantial effect of some kind upon the instrument to

doubt the calibration.

For more information on how to calibrate the instrument see Section 5 Calibration.

Opening Files
To open a file, go to File:Open, and select the corresponding .mic file.

When opening a file when using Auto-Collect, open the batch folder, open the folder
of the sample you wish to open, and open the .xml file.

Exicor Microlmager User Manual 24



Chapter 4: Software Interface

Setting Exposure

During the calibration, the software determines the optimal setting for the exposure
and brightness for a blank sample. Pressing the Auto set Exposure button sets the
machine to that value.

If the sample has low transmission, it is possible to use the slider bar to increase the
amount of light entering the camera. Left is minimum light and right is maximum
light. As you move the slider to the right, first the brightness of the LED increases.
When the LED is at maximum brightness, the camera begins to lengthen the
exposure to let even more light in. You can move the slider to the right until the
optimal brightness is achieved.

However, letting too much light into the camera will cause over exposure. In the
LIVE screen this will manifest itself in the pixel becoming red as shown in Figure 9.

' Exicor Imager 2015_12.22.14 32.30Green P . .

FILE TOOLS HELP

Controls Live lD‘““ ] | Live Datasets]
= 5 -

Blue | Green | Red

O||0

475nm | 535nm | 630nm

[LED Intensity 98% 79ms j

Auto expose

Auto set exposure

Objective
5 -

Live

Intensity

Sample

i -
Sample

( Offset ———— | °
Offset

[T] Use offset

Count

M o
0 50 100
Intensity

Mode

O o 4]

(Auto collect
Folder:
Interval: 0.0 seconds

Number of samples: 1

Auto collect

Mode: Camera: UI337xCP-N Controller: LED FPG/ Count: 0

Figure 9 Over exposure Live Screen.
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Changing Objectives

If the sample is taken when over exposed, it will tell you in the Data screen in the
upper left corner what percentage of the image was overexposed. An example is
shown in Figure 10.

v TR,
FILE TOOLS HELP
| Controls J Live] Data |

Blue Green Red -

D D 31% overexposed.

475nm | 535nm | 630nm

~Brightness 38% 77ms

=)

m

~Auto expose

‘ Auto set exposure J

~Objective

5x v]

~Sample

[ Camnla ]
Figure 10 Overexposure Data Screen.

Changing Objectives

It is possible to use any number of objectives with the Microlmager provided that
there is a calibration file associated with that objective. To see how to add additional
objectives, see Section 5 Calibration.

To change objectives, remove the objective physically from the machine and replace
it with the desired objective. Then select the correct objective from the drop down
menu. Finally, click the Auto Set Exposure button to readjust the light intensity for
that objective.

Fast Mode

If needed, it is possible to collect data faster than in standard mode. However, the
noise of the image will increase slightly.

To change from Standard to Fast Mode, click on the drop down menu under Mode to
select the desired speed.
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Chapter 4: Software Interface

Offsets

The offset button is found just below the sample button. Clicking this button will take
map the current retardation and angle of the image and then store it in memory to be
subtracted later.

After you take an offset, you can choose to use the offset or not by checking the box
next to the offset button.

Each color/objective combination will have its own unique offset. For example, if you
create an offset for a 2x objective using the red LED, you will only be able to use that
offset when the software is set to the red LED and the 2x objective.

Display of data

Data is displayed in 7 Different formats. Intensity, Retardance, Angle, Retardance
and Angle, Retardance and Intensity, Angle and Intensity, and all three together.

When displaying single sets of data the color map in the upper right corner provides
the legend to change the color scheme of the image. Clicking on the color map
brings up the screen shown in Figure 11.

-
& Colorbar Picker XS

R 255
. G 255

iB 255

Copy
255,255,255

Figure 11 Colorbar Picker.

To change between preset color configurations, such as grayscale, right click on the
left colored part and choose the color scheme desired.

To create a custom color scheme, you can add colors by clicking on the slider bar.
To choose what color you want a particular marker to be, click on it and then move
the selector in the hue generator to pick the color you would like.

To choose the maximum and minimum values of the color map, it is possible to
either use an auto setting by clicking the Auto max/min or Full max/min buttons on
the right side of the screen or setting custom values. Auto max/min will use the
pixels with the lowest and highest values to determine the maximum and minimum.
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Analysis

Using Full max/min will use 0 for the minimum and the systems highest allowed

value for the maximum.

Analysis

To access the data analysis tools, click on the tab in the upper right hand corner.
This will bring up a screen similar to what is shown in Figure 12.

Colorbar | Analysis

Analysis

Group | Retardance mean Retardance STD Anc

Counts/Distance

All 14738 0.76617 1.98
0 14026 0.23024 0.55
m
 Tools
Line ‘ ‘ Polyline
l Rectangle ‘ ‘ Polygon ‘
‘ Ellipse ‘
 View
Zoom +
‘ Zoom - ‘
‘ Reset ‘
( Retardance
o —0
g
3
E 0
v
(-3
PR B
0 10000
Counts/Distance
 Angle of the Fast Axis
N —0
c
5
£ 0
]
&
PRI N BTSN RS SR S|
0 10000 20000 30000

Figure 12 Analysis Toolbar
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Chapter 4: Software Interface

Statistics: Statistics of the current image are found in the upper part of the toolbar.
The first row will always have the mean and standard of deviation of the Retardance,
angle, and intensity of the entire image. If other shapes are created on the screen
then the statistics for each individual group will show up here as well.

Shape Tools: Several shape tools for drawing out data from specific parts of the
image are available. Examples are shown in Figure 13.

e Line- simple two point line. Finished with one click.

¢ Polyline- functions similarly as line, but with multiple vertices. Finished with
two clicks.

e Rectangle- simple rectangle. Finished with one click.
e Ellipse- all manner of round shapes. Finished with one click.
e Polygon- multiple lines but will enclose an area. Finished with two clicks.

o
@ i o

FILE TOOLS HELP
Controls Live| Data

Group Retardance mean Retardance STD ,*
Al [14738 076617
0 0.78027 079346
14145 023712

1

2 14774 076301
3 13226 068947
12372

—_— ¥ - s s
i . " »
- D : 1 Tools ——0
3 ¢ . Line Polyline
ngle

.
.
H
e U
ga !
A

Angle of the Fast Axis

Mode: Camera: UI337xCP-M __ Controller: LED FPGA Dr Count: 0

Figure 13 Shape Tool Examples.
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Analysis

Shape Tool Options: A variety of functions are available for each shape as well.
These are shown in Figure 14 and are accessed by right clicking on the shape.

)
e B = —

Y

7xCP-M  Controller: LED FPGA Dr Count: 0

Figure 14 Shape Tool Options

Move- moves a shape from one location to another.

Resize- allows the user to change the size of the shape.

Duplicate- allows the user to create an exact copy of the shape.

Copy data- this copies the histogram output of the shape to the clipboard.
Export data- this creates a text file with the histogram output in it.

Group- allows you to reassign the group number of a shape to include it with
another to view the statistics of both (or more) in the statistics box.

Delete- deletes the shape.

e Width- changes the width of the line of the shape.

Histograms: Histograms for the Retardance and the Angle of the Fast Axis are
found at the bottom of the Analysis Toolbar.

The histograms can be manipulated using the mouse.
e Left click brings back the value at that part of the histogram.
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Chapter 4: Software Interface

¢ Right click and dragging moves the histogram.
e The scroll wheel allows the user to move in and out.

e Hovering the mouse over either the x or y axis and using the scroll wheel
zooms only that axis.

e Clicking and dragging the scroll wheel allows a box to be drawn over a
selection and the histogram will zoom to fit.

The histogram for a line plot and a normal shape function slightly differently for now.
The line and polyline with have the retardation of each point as the line’s length. The
normal shapes will show the number of pixels (i.e. counts) at each retardation.

Multi-Order Samples

Occasionally, there is a need to measure retardation beyond the limit of a single
wavelength. To do this multiple wavelengths need to be measured and unwrapped
to find the correct order and value of a sample.

To complete this:

1. Measure the exact same area on two, three, or four wavelengths depending
on what hardware you have installed on your Microlmager.

2. The datasets (and all previous datasets) will appear in the data sets tab as
found in Figure 15.

 Exicor Imager: 2015_12_22_14 32 30,Green

FILE TOOLS HELP

Display Live| Data
( Intensity —— « )
e,

ST
> -]

(- Retardance ———

(Angle of the fast axis

"

Intensity

Min 000 AU Full min

(Retardance and intensity ——

(-Angle and intensi
o . L
- 0 100 200
) . Retardance
e

Mod

Count

Camera: UI337xCP-N Controller: LED FPG/ Count: 0 [————————

Figure 15 Dataset Tab.
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Auto-Collect

3. After clicking on the tab you will set a screen similar to Figure 16.

EE*OI‘MEZOE 12.22 14 32 30Green

FILE TOOLS HELP

Display Live| Data Colorbar | Analysis | Datasets

=t 3l + )| Previous datasets
201512_22_11 06_16:Green

(Retardance 201512 22 11 06_39:Red

201512_22_11_08_34:Unwrapped

(Angle of the fast axis

a
201512_22_11_09_54:Unwrapped

(Retardance and intensity

g Phase unwrapping
u")‘.)'o 22.263 Datasets to process
A("): -11.632) 2015_12 22 11 06_16:Green

[ Process ] [ Clear ]

Dispersion % b.?

Camera: UI337xCP-N Controller: LED FPG/ Count: 0

Figure 16 Datasets Window.

4. Although you will see all the previous datasets, click and drag only the
datasets that you want to include in the multi-order analysis to the “Datasets
to Process” area.

5. Then adjust the minimum and maximum expected retardation values if
needed and click process. The maximum value for a three color system is
about 4000nm of retardation.

6. It will take some time but the software will process the images and give you a
multi-order result.

Auto-Collect

Sometimes, it is desirable to collect a number of samples with some repeatable
amount of time between them. To do this, you can use the auto collect feature. It is
found in the bottom left corner as shown in Figure 17.
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Chapter 4: Software Interface

| Bicorlmager 201512.22.14 32 30Green BT T E‘mﬂ

FILE TOOLS HELP

Controls lTine [Data l Live Datasets]

Blue | Green | Red

O|=|0

475nm | 535nm | 630nm

[LED Intensity 98% 79ms j

Auto expose

Auto set exposure
Objective
5 -

Sample

Sample

r Offset ———————
Offset

[T] Use offset

Live

Intensity

Count

0 L
0 50 100
Intensity

Mode

Standard -

Auto collect
Folder:
Interval: 0.0 seconds

Number of samples: 1

Auto collect

Mode: Camera: UI337xCP-N Controller: LED FPG/ Count: 0

Figure 17 Auto Collect Main Window.
1. Start with click on the box next to “Folder:” This will allow you to choose
where to store the files from the measurement.

2. Then input the interval of time in between each scan and the number of
samples. Then click “Auto collect.”

3. A window similar to Figure 18 will appear. Click “Start” when ready.

Press start to begin collection.

Figure 18 Auto Collect Start Window.
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Auto-Collect

4. While the measurements are running, you will see a window similar to Figure
19. When the measurements are finished, you will see a window similar to

Started Batch: batch2015_12_22_14 51 42

Cycle 1: Acquiring Images

il Started at 12/22/2015 14:51:42 with 3 cycles.

Figure 19 Auto Collect Status Window.
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Calibration

Calibration Procedure
Calibration Procedure:

1. First, make sure the stage is level. Measure each edge of the stage as shown
in Figures 19 and 20. The stage will move slightly with light to moderate
pressure. If it isn’t possible to make the stage level, remove the panel behind
the stage with a M3 hex wrench, then loosen the stage, level it, and retighten
the screws. Check to make sure the stage is level again after retightening the
screws.

Figure 19.
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Calibration Procedure

Figure 20.
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Chapter 4: Software Interface

2. Open software. You will see a screen similar to Figure 21.

FILE TOOLS HELP
Controls

[

Blue

475nm

Green

O

535nm

Red

630nm

u

~Auto expose

Brightnes[% 49% 50ms —|

Intensity

| Awomopone |

—’Objective Sx—vl
~Sample
| sme |

e x

Display

1,

rAngle of the fast axis ﬁ .

Mode: Camera: UI337xCI Controller: LED FF Count: 0

Figure 21.
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Calibration Procedure

3. Select Calibration from the Tools dropdown menu on the menu bar. You
should see a screen similar to Figure 22.

.

Figure 22.

- : ;
& Calibrationinterface o |8 X
Calibration steps Data
[ — 100
“ . Instrument parameters £ 7 o Eit
O Intensity 1 u Qata
- . Fit
‘ Phase lag 80 = Data
J Fit
@ Amplitude . Data
y w— Fit
« @ L0 1
m Dat
scucions o _| 60 =
O Light intensity = 4
«@?2 |
4 @ Standard 40 4
@ Auto exposure ]
@ siank 7
. Retarder at 0° 20
@ Retarder at 22.5° b
. Retarder at 45° 4
@ Retorder ot 67.5° 0 ———— T
w ot - 0 20 40 80 100
Collection control Finish Set Retardance Report
| Lock retardance
Blue 125 nm
‘ OK ‘ Cancel Green 130 nm
Orange 140 nm
Red 142 nm

4. In the initial calibration, you will start with the instrument parameter
characterization. Taking data for the intensity, phase lag, and Amplitude. This
however, should only need to be done one time.

5. After making sure that there is nothing in the light path, click on the words

“Light Intensity.” Then click on the button that reads “Collect.”
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Chapter 4: Software Interface

6. The software will run through a procedure and you will see results graphing to
the side. When the software stops, click on the words “LED.” You should see
a window similar to Figure 23.

o @ % )
Calibration steps Data
4095
« Qe
. Light intensity
“ @5 3276
4 . Standard
. Auto exposure
@ siank 22457
- |
3 o
. Retarder at 0 S
. Retarder at 45°
é Retarder at 90° 1638
. Retarder at 135°
819
0
1.0 7.2 13.4 19.6 25.8 32.0
Collection number
Collection control Finish Report
E]

Figure 23.
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Calibration Procedure

7. Click on the “Fit” button. You should now see a screen similar to Figure 24.

&Calibnﬁmlnteml o B X
Calibration steps Data
r 120
« @ LD
. Light intensity
“ . S5x %6
/- . Standard

O Auto exposure

®:c: £72

. Retarder at g

Q

@ Retarderat 4

@ Retarder at 90 48

. Retarder at

24
0o
4.5 5.6 6.6 7.7 8.7 9.8
Collection number

Collection control Finish Report
Clear| |Save| | Fit ‘ Report’ ‘ OK ’ Cancel

Figure 24.

8. Now you will calibrate the instrument for individual objectives. To add
objectives, right click in the white area indicated by the blue arrow in Figure
24. This will allow you to add an objective.

a. The first time an objective is added, if the procedure is not completed
the objective will be deleted.

b. After a full initial calibration, the software stores the last known
configuration for that objective. If the calibration is interrupted or
canceled for some reason, the software will revert to the previous
calibration.

c. If you have calibrated one objective, exited, then opened the
calibration window again to add another, there is no need to recalibrate
each objective. The software will use the stored calibration for the
known objective and only the new objective needs to be calibrated.
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Chapter 4: Software Interface

d. NOTE: Optimal performance of the Microlmager system requires strict
adherence to factory calibration procedures, including the calibration of
optical objectives which have been sourced and characterized by
Hinds Instruments, Inc. The use of non-authorized optical objectives,
or any objectives that have not been fully-characterized according to
factory specifications, may result in non-optimal data. While it is
possible to calibrate the instrument with an objective not provided by
Hinds Instruments, performance is not guaranteed and Hinds
Instruments bears no responsibility for results with non-qualified
objectives.

9. Using a similar procedure as before, click on Auto Exposure under the
desired objective then click the Collect button. Redo the same process,
clicking on the words and then clicking collect, for the rest of the
configurations.

a. NOTE: Make sure that the light path is clear for “Auto Exposure” and
“Blank.”
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Calibration Procedure

10. For the final eight configurations, line up the calibration sample provided by
Hinds Instruments onto the objective as shown in Figure 25.

Figure 25.
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Chapter 4: Software Interface

11.Be sure the front of the rotator is square to the stage as shown in Figure 26.
This is best accomplished by raising the stage to support the mount. (This
also ensures that everything is flat)

Figure 26.
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Calibration Procedure

12.Tighten the screw as shown in Figure 27 to center the optic under the
objective, place blue mounting putty as shown in Figure 28 to keep the optic
from moving. It is important that the optic be as flat as possible with
respect to the optical train.

Figure 27.
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Figure 28.

13. The software requires the calibration sample to be measured at eight different
orientations. These are represented in the software by 0, 22.5, 45, 67.5 90,
112.5, 135, and 157.5 degrees. For sign convention continuity, rotate the
optic to read 0 for the 0 degree measurement, 22.5 for the 22.5 degree
measurement etc.
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Calibration Procedure

14.Measure the sample at each of the eight configurations. At the end, all the
circles should be green as shown in Figure 29.

& Calibrationlnterface | SIS
] Calibration steps Data
2641
4@ D
(] Light intensity
“@5x 2171
4 O Standard
. Auto exposure
@ slank §17o1
E
. Retarder at 0° 8
. Retarder at 45°
. Retarder at 90° 1230
. Retarder at 135°
760
290
1.0 2.2 3.4 4.6 5.8 7.0
Collection number
Collection control Finich Report
Collection control Finich Report

=Ir = =

Figure 29.

15.Then click on the word “Standard” and then click the button labeled “Fit.”

16.1f desired, a report of the data can be generated at this step by clicking
‘Report’. This file will contain comma separated text describing the results of
the calibration.

17.1f needed, it is possible to add objectives here and calibrate those following
the same procedure. When finished click OK and restart the software.
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Basic System Check

Maintenance

The Exicor® Microlmager requires very little maintenance.

Basic System Check

Check periodically, and when system maintenance is performed, that the covers on
the source and detector modules and the control system are secured properly. Be
certain that no unwanted light escapes from the source module.

Check periodically that interconnecting cables are free of sharp bends and cuts or
abrasions.

For safety, the instrument housings should be opened only by authorized
maintenance personnel.

Persons changing the cables or opening the covers on the system must:

¢ Remove power to the system.

¢ Understand the purpose, connections and voltages at each cable connection.
e Understand the hazards associated with bright LED light.

¢ Not allow eye exposure directly from LED light or any reflection of LED light from
a mirror like surface.

e Understand all mechanical and electrical hazards that exist in the system.

Cleaning the Exterior

When cleaning the exterior of the Exicor Microlmager, care should be taken not to
scratch the surface or let liquids get inside the system.

An ammonia-based cleaner (such as glass cleaner) works well for cleaning the
outside. Do not allow any liquids to get inside the sample stage components or top
and bottom modules.

CAUTION

To avoid electrical shock and equipment damage, do not allow
any liquids to get inside the Exicor Microlmager. Do not clean
the system with the power ON or while the system is plugged
into an AC outlet.
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Troubleshooting & Help

Diagnosing Common Errors

Table 2 Diagnosing common errors lists some of the most common errors that have
been encountered and suggestions on how to interpret or fix the error.

Symptom Common Causes

Actions

Start/Stop switch will

not turn system on DC power cord not plugged in

Plug in DC power cord

USB 3.0 cable not plugged in.

The software can'’t USB is plugged into USB 2.0
2. connect to the port.

camera
The computer went into sleep
mode.

Plug in the USB 3.0 cable.

Make sure cable is plugged into USB 3.0
port.

Unplug and then plug back in the USB
3.0 to turn the camera off and then back
on again.

Wrong setting of objective is
Measurements are being used

Verify that the objective in the machine
matches the settings under which it was
set.

freezes

3. not close to
expected values The camera is being over Use the factory setting for exposure or
exposed.
turn the exposure down manually.
Unplug the USB cable from the
computer and turn off the system. Then
The software i plug the cables back in and turn the
4, An error within the software

system back on. Be sure to plug USB
cables back into the same port on the
PC.

Table 2 Diagnosing common errors

Exicor Microlmager User Manual

50




Chapter 6: Troubleshooting And Help

Contacting Hinds Instruments

If it is necessary to contact Hinds Instruments for support, refer to the following table
for the company contact information.

Method Information
Teleohone Monday - Friday 8:00 AM to 4:00 PM PST
P (503) 690-2000
FAX (503) 690-3000
Email support@hindsinstruments.com
World Wide . .
www.hindsinstruments.com
Web
Shipping Hinds Instruments, Inc.
Address 7245 NW Evergreen Pkwy.

Hillsboro, Oregon 97124

Table 3 Contacting technical support

When contacting Hinds Instruments for technical support, have the following system
information available:

e Model name

e Serial number

e Problem symptom

e Exicor data files, .ini file, and offsets files (if applicable)

Exicor Microlmager User Manual

51



A

Technical Specifications

The Exicor Microlmager is an easy-to-use system for imaging the birefringence in
optical materials. The system includes a sample stage to move the sample for
measuring areas up to 76 x 50 mm and function with 2X, 5X, and 10X objectives.

General Specifications

Software:

Computer System:
System footprint area:
System height:

Stage Travel:

Weight:

Power Required:

Exicor™ Microlmager (025-0000-075) Ver. 1.0
PC, Windows™ operating system, LCD monitor
267 mm x 305 mm

705 mm

76mm x 50mm

~12 kg

100-240VAC, 1.5A MAX, 50/60Hz

Measurement Specifications

Wavelength:

Field of View:
2X
5X
10X
20x

Resolution:
2X
5X
10X
20x

450, 530, 632 nm

5.69 mm square
2.27 mm square
1.14 mm square

0.56 mm square

5 microns
2 microns
1 micron

0.7 micron
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Specifications

Microns/Pixel:

2X 2.78 microns
5X 1.11 microns
10X 0.56 microns
20x 0.27 microns

Fast Axis Angle

Units: degrees (°)
Range: -90° > +90°
Resolution: 0.5 Degrees

Software Features

A system-specific software program provides the following:
e Graphical user interface

e Multiple wavelength Measurement

e Multi-order retardation measurement

e Auto-exposure

e Data saved in binary format

¢ Plot options

e Color plot of all measurements

e Copy and paste graph to MS Office applications

e Automated data collection and analysis of samples

e On-screen graphing of sample data

e Automatic calibration check, system initialization, and system status monitoring

CE Approval

1. To comply with CE regulations, all I/O cables connected to the Exicor
Microlmager must not exceed 3 meters in length.

2. To comply with CE regulations, the Exicor Microlmager system connection cables,
originally shipped with the system, must be used to connect the system. Only
replacements configured the same way are allowed.
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Exicor® Microlmager
Limited Warranty

Hinds Instruments, Inc. warrants the Exicor ® Microlmager to be free from defects in
materials and/or workmanship for (1) year from the date of delivery, subject to the
provisions contained herein. Hinds’ warranty shall extend to the original purchaser
only and shall be limited to factory repair or replacement of defective parts.

Exclusions

This warranty does not cover consumable parts, normal maintenance or damage
resulting from improper use or repair, or abuse by the user. This warranty extends
only to repair or replacement, and shall in no event extend to consequential
damages. In the event of user repair or replacement, this warranty shall cover
neither the advisability of the repair undertaken, nor the sufficiency of the repair
itself.

THIS DOCUMENT REFLECTS THE ENTIRE AND EXCLUSIVE UNDERSTANDING
OF THE PARTIES, EXCEPT AS OTHERWISE PROVIDED HEREIN. HINDS
EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED,
PARTICULARLY THE WARRANTIES OF MERCHANTABILITY AND/OR FITNESS
FOR A PARTICULAR PURPOSE FOR THE PRODUCTS, SOFTWARE, OR
SERVICES CONVEYED. THE OBLIGATIONS SET FORTH IN THIS SECTION
SHALL BE HINDS’ SOLE LIABILITY AND BUYERS’ SOLE REMEDY, FOR
BREACH OF THE FOREGOING WARRANT. REPRESENTATIONS AND
WARRANTIES MADE BY ANY OTHER PERSON, INCLUDING DISTIBUTORS,
DEALERS AND OTHER INDEPENDENT REPRESENTATIVES OF HINDS WHICH
ARE INCONSISTENT OR IN CONFLICT WITH THE TERMS OF THIS WARRANTY
SHALL NOT BE BINDING ON HINDS UNLESS REDUCED TO WRITING AND
APPROVED BY AN EXPRESSLY AUTHORIZED OFFICER OF HINDS.

This warranty gives you specific legal rights, and you may also have other rights that
vary from state to state.

Warranty Service

If you find any defects in material or workmanship or any failure to meet the
specifications, you must notify Hinds within the warranty period and obtain a Return
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Non-Warranty Repairs

Material Authorization Number (RMA#). This can be done by calling Hinds
Instruments at 1-800-688-4463, or by emailing our service department. Return the
product to us in proper packaging, freight and insurance prepaid, and clearly marked
with the RMA#, and we will either repair or replace it, at our option.

Non-Warranty Repairs

If a product that is not covered by the above warranty needs repairing, we will first
provide an estimate of repair charges and then repair the product upon receiving
authorization from you. Repairs are warranted for ninety (90) days from the date of

delivery.

Reference chapter 7 (Troubleshooting & Help) on page 50 for contacting technical
support.
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